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1 Rock Block

1.1 Introduction

RockPlane is a GeoStru Software S.a.S. product for the evaluation of

stability of blocks of rock embedded in a slope that may potentially

overcome frictional and retaining resistance and slide downwards. The

product further evalutes and designs support works in the form bolts or

tiebacks to achieve a given level of safety factor, taking into account

possible seismic events and water pressures.

The program operates on blocks of conceptually gemetrically regular

dimensions in two dimensional plane where a unifom depth of the block

is used to evaluate its mass.

The basic form of the block is shown in the figure below:

This basic rhomboid form may reduce to one of two triangular forms

where:



Rock Block 2

© 2020 GeoStru

1.  Base slide surface vector extends to intercept head surface vector

without the occurrence of a fracture;

2.  Fracture vector intercepts the Slope surface before the slope/head

crest.

Note:
Geostru company created a service available on the Geoapp web page

where there are several applications for making online calculations. Some

of these can be used together with Rock Plane, for example: Nailing;

Stability analysis of flat surfaces; Cunei3D etc., more details are shown in

the Geoapp Section  of this Help.

1.2 Menu

1.2.1 File

The File menu contains those functions that enable the insertion, recall,

printing and closure of project files and their management.

New
Creates file(s) for a new project. (Function is also available from the

Standard toolbar)

Open
Opens file(s) for a previously created project (Function is also available

from the Standard toolbar)

Save
Save file(s) for the currently open project, replacing any previous

version. (Function is also available from the Standard toolbar)

Save As
Save file(s) for the currently open project under the name and in the

folder, to be entered in a subsequent dialogue window. This creates a

new file with that name. If the file already exists the user is asked to

confirm that it should be overwritten

10

https://www.geostru.eu/it/geoapp/
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Preview
Presents preview  of worksheet printed page(s) with dialog window for

the control of the printed image.

Project Example
Generates example project.

Recent Projects
Recalls the names of the last three open files.

Exit
Program exit.

1.2.1.1 Graphic Print Preview

When this command is invoked it opens the Print preview dialog window

displaying a print preview of the drawing in the worksheet set up to print

at a scale such that it will fit on the predefined page size.

In the preview window are present a number of menu functions which

affect the print result without affecting the original in the worksheet. One

of these invokes printing of the image to the predefined printer.

The commands are:

Move
Pressing this button causes the mouse pointer to change to a hand and

can be used to ‘take’ (click) the drawing and move it (drag) elsewhere

on the paper as seen in the preview.

Scale + e Scale - 
Alters the scale of the drawing up or down in steps of 100:1. The scale

adopted is displayed in the plan scale frame. See also Plan Scale factor .

Plan Scale
Displays the scale at which the plan diagram will be printed. May be

altered as desired. Press enter to actuate the new scale.

Fit to page
Adjusts the scale of the image such as to fit on the defined page size

exactly. The scale adopted is displayed in the plan scale frame. (Selection

of paper size and orientation occurs in the Set Up printer in the File

menu).

3
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No. of Copies
Default is 1.

Print
Prints the preview image on the predefined printer (see Set Up printer in

the File menu).

Exit

1.2.2 Edit

The Edit menu presents those functions relative to editing data for the

currently open project.

Copy
Copies to the clipboard the selected area of the active window. (Function

is also available from the Standard toolbar). This function is particularly

useful to copy bitmaps of images in the various phases of computation

to a preferred editor (Word, Works etc.)

Cancel Bitmap
Remove any previously inserted on the worksheet.

1.2.3 View

Redraw
Redraws the drawing correcting any defects due to editing process.

(Normally caused by editing of the contents)

Move
Moves the image by dragging with the mouse. Dynamic interactive

preview is given.

Zoom
Opens a submenu  to give access to one of the many options to

enlarge or reduce the current image dimensions. Note Zoom does not

alter any of the dimensions of the drawing but only it's display.

Mirror
Mirrors the entire section, but not the block.

5
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Text size
It is possible to assign a size to text.

Apply as elevation attributed vertex
When you click on the vertex, is displayed your elevation.

Insert text
With this command is possible to insert a text in worksheet.

Delete text
With this command is possible to delete a text.

Distance
Is possible to measure the distance between two points.

Esc
It permits to get out of the activated command.

1.2.3.1 Zoom

Enables alteration in the view of the worksheet, to either reveal greater

detail or obtain a more distant view in the manner of a camera zoom.

A plan is a life-size drawing on a virtually unlimited surface. The drawing

window is like a camera lens focused and centered on part of that

unlimited paper.

Through the lens of the drawing window you can zoom out to see your

entire drawing (reduced to fit the screen), or zoom in for a magnified

view of a detail. Later, when you use a printer to get a paper copy, you

can scale it to fit the paper or to any predetermined scale.

The effect may be varied with the following commands:

Zoom Window 
Lets you draw a selection rectangle or "window" to view part of your display

in the drawing window. Use the left button to select one corner of the view

you want. Now the cursor becomes a stretching rectangle. Select a second
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corner for the view. The screen is redrawn to show the part of your drawing

that fits within the rectangle.

Dynamic Zoom 

Provides an interactive zoom effect using the mouse to control it.

Once the left mouse key is pressed the pointer alters into an enlargement

lens. Dragging the pointer upwards increases the size of the image, while

downwards drag reduces it. The zoom factor may be read in the toolbar

display.

Previous Zoom 

Returns to the zoom factor current before the last operation.

Zoom All 

A zoom factor is applied, such that the whole contents of the worksheet are

displayed.

The same functions are available on the toolbar where a frame indicates the

zoom factor. This figure may be altered (press enter) to achieve an exactly

defined zoom factor.

Note: Zoom does not alter the absolute dimensions of the drawing and does not
impact on its scale when printing.

1.2.4 General Parameters

This menu enables the parameters for the project to be entered.

Profile vertex
With this command is possible to insert the vertex to define the slope

section.

Delete vertex
It is possible to delete the inserted vertex.

Apply as elevation attributed vertex
When you click on the vertex, is displayed your elevation.

Block Parameters

Support Parameters

7
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1.2.5 Computation

Click on compute or the tool bar icon to perform the calculation on the

latest entry data and prepare the computation report.

To perform the report the Block Parameters  and Support

Parameters  must have been entered.

1.2.5.1 Geometry

This screen is used to define or modify the physical and mechanical

characteristics of the block under consideration.

Refer to the diagrams in Introduction  topic to fill the geometrical

characteristics.

Angles are measured from the horizontal plain in an anticlockwise

direction.

Apart from individual limits, they will take the values from zero to 180°.

An exception is the angle of the surface from crest and beyond. This may

be ascending i.e. continuing to rise even if at a lower angle than the

slope, or it may descend from the crest downwards.

A descendant vector is entered as –ve angle.

So that 10 means continuing to rise at an angle of 10°; 0 (zero)

flattening out; -10 descending at 10° below the horizontal.

As sufficient data is entered a prototype of the block is drawn in the pane

beside the values. Altering the values will be reflected in the pane.

An information display gives extra help for each variable as it comes into

focus.

Continue thereafterto enter the mechanical characteristics.

If the location is subject to seismic effects. then also select values from

the drop down lists for ordinate and abscissa coefficients.

7
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1.2.5.2 Anchors

On request this screen enables tieback characteristics to be recorded so

that the capacity may be calculated.

Among the other parameters the required safety factor can be entered

as also the role of the support. Entry of these parameters is required

before calculation can be performed.

1.2.6 Export

Enables selection of export format for the calculation results.

Generate RTF Report
Generates the computation report in an internal editor  window. 

This provides its own File menu with Print and Save functions Save

occurs in RTF (Rich Text Format) format which may be read by most

text processing programs (MS Word, Lotus Word Perfect, etc.).

Export in Bitmap format 
Export in BMP format the contents of the worksheet window.

 

Exported file have the same name as the project with unique suffix and

the type ( BMP, RTF) .

1.2.6.1 RTF Edito

The program includes an internal text editor which enables text, such as

reports, to be produced edited and saved using RTF format.

RTF (Rich Text Format) is a document format that is compatible with all

major text processing programs. This format may be read by these text

processors (Word, Word Perfect etc.) and thereafter edited and saved in

the text processor native format.

The editor may be invoked by requesting RTF Export or from the toolbar.

When invoked the editor is opened and the program’s data report is

presented. Thereafter the user may modify and/or enhance its aspect or

contents at will, and/or save or print it.

Basic text processing functions such as editing, tables, margins, tabs, and

formatting are available

8
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When the editor is closed, control returns to the original program.

1.2.7 Preferences

Menu for the assignment of options for the operation of the program.

Options
Opens the Options window in which the following may be determined:

Worksheet

· Line & background colours.

· Line thickness.

· Cursor tolerance.

· Grid interval.

Language Selection
Opens a Flags window to enable an alternative language to be set. After

an alteration, closing the window initiates the program closing sequence.

On restart the new language is operative.

2 Geoapp

Geoapp: the largest web suite for online
calculations
 
The applications present in Geostru Geoapp were created to support the

worker for the solution of multiple professional cases.

Geoapp includes over 40 applications for: Engineering, Geology,

Geophysics, Hydrology and Hydraulics.

 

Most of the applications are free, others require a monthly or annual

subscription.

 

Having a subscription means:

 

https://geoapp.geostru.eu/?lang=en
https://geoapp.geostru.eu/apps/?lang=en
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• access to the apps from everywhere and every device;

• saving files in cloud and locally;

• reopening files for further elaborations;

• generating prints and graphics;

• notifications about new apps and their inclusion in your

subscription;

• access to the newest versions and features;

• support service throught Tickets.

2.1 Geoapp Section

General and Engineering, Geotechnics and
Geology  

 

Among the applications present, a wide range can be used for GeoRock.

For this purpose, the following applications are recommended:  

 

Ø Nailing passive bars

Ø Tiranti

Ø Analysis stability of flat surfaces

Ø Rigid and elastic rockfall barriers

Ø 3DWedge

Ø Slips along a plane

Ø Anchored mesh systems

3 Contact

GeoStru 

Web: www.geostru.com

https://geoapp.geostru.eu/app/chiodatura-barre-passive/?lang=en
https://geoapp.geostru.eu/app/tiranti/?lang=en
https://geoapp.geostru.eu/app/analisi-stabilita-dei-pendii/?lang=en
https://geoapp.geostru.eu/app/barriere-paramassi-rigide-ed-elastiche/?lang=en
https://geoapp.geostru.eu/app/cunei-3d/
https://geoapp.geostru.eu/app/scivolamento-lungo-un-piano/?lang=en
https://geoapp.geostru.eu/app/anchored-mesh-systems/?lang=en
http://www.geostru.com
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